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About ActionItemsTM 
 

ActionItemsTM is a one-of-a-kind software application made specifically for note-taking and 
action item tracking.  It’s the perfect information management tool that keeps the busy 
individual organized, focused and on schedule. Consider ActionItemsTM an electronic 
assistant that goes with you everywhere and archives info, timelines and initiatives at your 
fingertips for instant recall, retrieval and action. 
 
Use ActionItemsTM as a personal journal to record notes of all kinds – from business 
meetings to grocery lists.  Organize action items by people, projects, and groups. Send 
and receive items over your network. Easily track their progress and completion in one 
centralized location.  Create custom reports that can be saved and shared.  Sort to-do 
lists by importance and/or due date with the click of a mouse.  Best of all, never, EVER 
again waste time re-typing hand-written meeting notes into your computer – 
ActionItemsTM turns your Mac into the ultimate note-taking and action item tracking 
device. 
 
ActionItemsTM is the perfect workgroup solution, enhancing communication and follow-
through between co-workers and direct reports.  Action items and notes are easily 
shared between groups, complete with due dates and priorities, and will come up for 
review at the click of a button. ActionItemsTM archives person and project data 
indefinitely, so recall and tracking is a breeze for both employee and boss. 
 
ActionItemsTM is a feature-rich program that allows the end-user to take command of 
their tasks and priorities.  Start using ActionItemsTM and instantly improve your 
efficiency, organization and follow-up, at work and at home!  
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Features  
 
Below are detailed sections on the unique features inside ActionItemsTM Notes-to-Action 
Software.  Please read carefully, it is loaded with useful information! 

 
Journal  
The Journal is the primary place to record meeting notes, lists, thoughts -- anything 
you need or want to annotate.   

 
 Entering Journal Notes 

ActionItemsTM captures notes in outline form, generally regarded as the most 
efficient way of organizing information.  To begin entering notes inside the 
Journal, click on the date and press “return”.  This automatically activates the 
first line.  Enter your text, then press “return” to start the next item.   
 

 
 
To indent, press the “tab” key; to outdent, hold the “shift” key while pressing 
“tab” – or use the Indent and Outdent functions under the “Outline” menu.  
Continue entering line items until your outline is complete. 
 
Backing up ActionItemsTM Data  
To create a backup of your data file, go to “Backup Database” under the File 
menu.  The window will prompt you to select a location for your backup.  
Backup can be done at any time to any location. 
 
Restoring ActionItemsTM Data 
To restore your data file, go to “Revert to Database Backup” under the File 
menu.  The window will ask you to select a backup file.  This will replace your 
current file with the selected backup data, and requires that ActionItems be 
restarted for the change to take effect. 
 

 
Think of the Journal as a spiral-bound notebook or sticky note, both 
places where one might traditionally write notes in long hand, with 
one major difference -- ActionItemsTM turns linear, hand-written 
notes into dynamically sortable, trackable and distributable action 
items. 

 
  
 Viewing Journal Notes 

The journal default view displays the present day. If you need to view a 
different day, simply use the calendar to select the desired date.  You may also 
use the calendar to select multiple days for viewing in a combined Journal 
outline. 
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Viewing Consecutive Days in the Journal   
In the Journal view, use the mouse to click the start date on the calendar.  
Drag your cursor through to the end date.  Or, click on the start date, 
hold down the shift key and click on the end date.  
 
Viewing Non-consecutive Days in the Journal 
Click on the start date, then while holding down the command key, click 
the other dates individually. 
 

When more than one day is selected, your journal outline will combine the 
individual daily outlines into one master outline.  
 

Parents and Children 
Any item that has one or more items indented beneath it is known as a 
“parent”.  The indented items below it are known as “children”.  Parent 
items can be expanded and collapsed for easier viewing by using your 
mouse to click on the arrow next to the item.  You can also use the left 
and right arrow keys to expand and collapse when the parent item is 
highlighted. 
 

From the Outline menu, you can change the layout of your entire Journal 
outline for easier viewing and usage. 

 
Expand All  -  opens the entire notes field  
 
Expand To -  expands all outline items to a selected level. Items below 

the selected level will be collapsed 
 
Collapse All -  collapses all outline items to the root, or top level. 

 
The standard program window view includes the Journal on top, with the 
Navigation area along the bottom. For variable panel sizes, pull down/up on the 
vertical and horizontal splitter bars, which will minimize or enlarge the viewable 
areas. 
 

To completely expand the Journal, click on the  button in the lower left 
hand corner of the program window.  This action hides the Navigation area, 
giving you a full screen view of Journal notes (you may also double-click on the 
splitter bar).  To restore the original view, click on the icon again. Clicking on 

the  button will hide, and unhide the calendar.   
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People, Projects and Groups 
The two major entities that receive action items are 
labeled People and Projects.  In order to assign an 
item to a person or project, the person or project 
must first be set up inside the ActionItemsTM 
database. 

 
 
 
Adding a Person 
 
1) Click on the arrow 

beside the“+” 
button and select 
“New Person”.   

 
2) Fill out the requested 

information in the dialog box 
and click “save”.  Or, to add 
another person, click on 
“Add Another”.  Continue in 
this fashion until you are 
done. 

 
Note:  in order to use ActionItemsTM in a workgroup environment, you must create a 
record for yourself.  Fill in your first and last name as others would use it, plus all 
other pertinent info.  Then, highlight the record, and go to “Person/Identify as me”.  
This will allow others on the same subnet to “see” you. 
 

 
Importing Contacts from Address Book 
To import contacts from your address book, 
select “Import” from the File menu. The Import 
Assistant will automatically pull in selected 
contacts from your address book, complete with 
all vital information. Select “Keep synchronized” 
so that anytime you change information in the 
Address Book, the info is automatically updated 
inside ActionItemsTM.  Or, choose “Import only” 
to download the data with no linkage.   
 
To access the address book for a particular 
record from inside ActionItemsTM, double-click 
the person’s name and click the “Open in 
Address Book” button. 
 
 

“Hot Key” designations may be entered for each person at this time.  For more 
information on Hot Keys, see page 13. 
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Adding a Project 

 
1) Click on the arrow beside the“+” 

button and select “New Project”. 
 

2) Fill out the requested information 
in the dialog box and click “save”.  

 
“Hot Key” designations may be 
entered for each project at this time.  
For more information on Hot Keys, 
see page 13. 
 
 
ActionItemsTM keeps track of original 
due dates, revised due dates and 
completion dates for each overall 
project, as well as any notes you may wish to keep on file.  The “Notes” field 
is the perfect place to capture a general description of the project, how it 
came about, and its stated purpose and goals. 

 
Creating Groups 
Groups are the perfect way of organizing related people and projects, such as 
Marketing, Family, Hobby, etc.  People and Projects can belong to more than 
one group.   
 
1) Click on the arrow beside the“+” button and select “New Group”. 
 
2) Type the name of your new group and click “OK”. 
 
People and Projects can be assigned to Groups by performing a simple Drag 
and Drop.  You may create new People and Projects while inside the group; 
they will be automatically added to that group. 
 

  Creating “Favorites” for People and Projects 
ActionItemsTM allows you to quickly access frequently viewed outlines by 
listing them across the top of the program window, otherwise known as the 
“Favorites” bar.  A quick click on a header takes you to the desired outline.  
The Journal is the only default favorite, however, recently viewed People and 
Projects will appear across the top as you view them.  You can customize the 
number of recent items displayed as favorites.  You may also create 
permanent favorite status for frequently viewed outlines, change the display 
order of favorites, and delete favorites. 
 

Recently Viewed Items 
ActionItemsTM will automatically display the most recently viewed People 
or Project outlines across the top window, along with the Journal.  To 
adjust the number of recently viewed items displayed as favorites, go to 
“General” in the “Preferences” menu.  Select a number between one and 
nine in the clickable window.  
 
Creating Permanent Favorites 
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To create permanent favorites for frequently viewed People or Projects, 
simply drag the item between the divider bars to the right of the 
“Journal” header.  All headers appearing between the bars are 
permanently displayed for easy access.  

 
Changing Display Order/Deleting Favorites 
To move favorites to the left or right, perform a drag and drop until all 
titles are in the desired position.  You can also remove a favorite by 
dragging it outside the divider bars until the item “ghosts”.  It will 
disappear upon release.  The favorite will now be displayed only when it 
has been recently viewed. 

 

 
 
 

ActionItemsTM allows you to organize, store and retrieve data  
much as you would with a paper filing system.  Keep “folders” 
on people and projects, group related items in larger “Group” 
folders, and store frequently accessed data at your fingertips via 
the “Favorites” feature. 

 
 

Navigation Area 
The lower half of the program window is referred to as the Navigation area, which 
allows you to easily switch between views and functions. Navigation consists of 
two panels: Directory and Listing.  The viewing area of each panel can be 
adjusted both horizontally and vertically via the splitter bars.  Collapse the area 
completely when working on your outlines; expand it to navigate to different 
views, to set up new People and Projects, and to send and receive Live Action 
Items (see page 17).   

 
Directory 
From the Directory you can select a group, project or person, click to view 
Upcoming Items, perform and access searches, access reports and report 
templates, and check your ActionItemsTM Inbox.  
 
Listing 
Use the black arrow in the upper right hand corner to add/delete viewable 
columns.  You can also change the display order of the columns by performing 
a drag and drop to the desired location. 
 

 
 

People 
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When “People” is selected inside the Directory, the Listing panel will display a 
list of all people entered into your ActionItemsTM database, along with their 
respective Hot Key, Hot Text (if entered), number of pending and assigned 
items, and online status (if using in a workgroup situation). Status bullets for 
people appear as follows: 
 

Your personal record:  each person should have a personal entry, 
created in the normal fashion (see page 7).  Highlight your personal 
record, then select “Identify as Me” under the  “Person” menu.  The icon 
next to your name will appear in blue. 
 
Note: designating a record as ”you” is critical when using ActionItems in 
a workgroup situation. This will enable you to send and receive action 
items amongst other ActionItemsTM users. 
 
Imports from address book:  will appear with a small address book 
icon.  Unless on your network, these people are not able to send or 
receive Live ActionItems (page 17), but you may create and maintain 
outlines for them.  
 
Users on the local network: When a local user has their ActionItemsTM 
software running, their bullet appears in green; when offline, the bullet 
disappears. Users must have their program open in order to receive Live 
Action items, otherwise, items will remain in your Pending with a yellow 
button.  For more on Live Action Items, see page 17. 

 
 

 
 
Projects 
The Projects selection inside the Directory results in a list of all created Projects 
inside your ActionItemsTM database.  Use the black arrow to display additional 
info, including Hot Key, Hot Text, number of pending and assigned items, 
original due date, current due date, and date completed. 
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Groups 
Select “Groups” inside the Directory to create custom groups, such as 
Family, Marketing, Hobby, etc.  Expanding “Groups” will also allow you to 
select a specific group to view.  Use the black arrow to display additional 
info, including Hot Key, Hot Text, number of pending and assigned items, 
online status, original due date, current due date, and date completed.   
 

 
 

 
 
Upcoming 
Selecting “Upcoming” will display all items due within the selected timeline.  
Sort upcoming items by Owner, Due Date and/or Priority by clicking on the 
respective header.  To view Upcoming items for a particular Person or 
Project, select “Upcoming” from inside the Directory, and then click “For 
current selection” along bottom of window.  Items may then be sorted by 
Owner, Due Date and/or Priority by clicking on the respective header.   
 
If you are in the Journal and select Upcoming, you will see a list of all items 
due across all people and projects. 
 
Search 
ActionItemsTM searches your data for specific items with a variety of 
selected criteria.  Searches can be saved for re-use.  
 
Select “New Search” from the file menu. Choose your search criteria and 
enter your text string in the area provided.  You may add additional criteria 
by clicking on the “+” button.  When your selection is complete, click 
“Search”. 
 
Reports 
Allows you to run a “QuickReport” template, create a custom report, and 
run saved custom reports.  For more on reports, see page 21. 
 
Inbox 
Displays all items that have been assigned to you via “Live Assign”.  For 
more on Live Assign, see page 17. 

 
 
Assigning Action Items 
Items can be assigned to various people, projects or groups by utilizing the built-in 
drag-and-drop features of ActionItemsTM, or via the use of “Hot Keys”.   Both are 
incredibly easy to use, and are best suited for certain applications. 
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 Establishing “Hot Keys” 
A “Hot Key” is shorthand for a 
particular person or project. Hot keys 
instantly assign ownership to items as 
you type, and if desired, inserts “Hot 
Text” inside the item.  Hot Keys consist 
of a symbol (/, etc.), followed by a 
short text string (the initials of the 
person or project, or a short name, for 
example). 
 
You can designate the hot key symbol 
of your choice inside the Preferences 
area under the ActionItemsTM menu 
(see window, right).  The text string is 
entered at the time a person or project 
is set up, or after import.  Use a 
different symbol to create “standard” 
action items, and “SuperItems”. The 
default Hot Key symbols are “/” for a 
standard action item, and “\” for a 
SuperItem. 
 
For information on SuperItems, see 
page 14. 
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Example:   
For a person named “Joseph Ball”, choose the hot key designation “JB”, 
and hot text designation as “Joe B.”.  Let’s assume you’ve established 
your hot key symbol as “\”.   
 
 
To assign an item to Joseph Ball while typing in the Journal or an Assigned 
Outline, enter “\JB” anywhere in the item.   
 

 
 

 
As the program recognizes the hot key, it will instantly replace it with hot 
text (if entered), and a copy of the item will instantly appear in Joseph 
Ball’s “Pending File”.  You will also see Joseph Ball’s name appear in the 
“People” column next to the item.  
 

 
 
You now have an action item in Pending, ready to be assigned! 
 
ActionItemsTM prevents you from using the same hot key designation for 
more than one person or project, ensuring the integrity and cleanliness of 
your data! 
 
 

Drag and Drop  
Drag and drop is another way to assign an item to a person or project that is 
currently visible in the Listing window.  Dragging and dropping an item onto a 
Person or Project puts that item into their “Pending” outline for review.  Items 
may then be formally assigned, amended or deleted (more detail below). 

 
 
Hot keys are a timesaver because you can send an item to 
pending for a person or project without any extra steps.  
Simply type their hot key inside the item and it’s all taken 
care of for you.  Use “hot text” for things like callbacks, etc., 
where the project or person’s name makes sense inside the 
item (see example above).  Note: you have the option of 
disabling the HotText feature if so desired.  Leaving the hot 
text field blank will prevent text from entering into the item. 
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SuperItems 
Items may be assigned to more than one person or one project.  They may 
also be assigned to both people and projects at the same time.  To do this, 
simply drag and drop the item to each entity you would like to assign 
ownership, or enter as many hot key designations as required. 
 
When assigned to multiple entities, the items exist independently of each other 
– changes to the item in one outline will not change it in a different outline. 
You may, however, choose to link the items together by creating a 
“SuperItem”.  SuperItems are useful when assigning an item to more than one 
owner.  Changes to the original item will automatically take place wherever the 
item exists inside your database. 
 

Creating SuperItems   
SuperItems are created by using a different Hot Key signifier as 
designated in the Preferences window (see page 12).  SuperItems are 
differentiated from a standard action item by a blue bullet point (versus 
grey for a standard item).  If an item is assigned to a project or person as 
a SuperItem, the person or project link will appear in italics. 
 
Modifying and Unlinking SuperItems 
To modify a SuperItem, click on the link in the “Origin” column, which 
takes you to the source notes for that item.  Modifications here will 
transfer to all outlines where the item also exists.  SuperItems cannot be 
changed from inside individual outlines – only at the source.  However, 
you may unlink SuperItems by highlighting the item and selecting “Unlink 
from Source” from the “Outline” menu.  That particular item is now 
independent from the others, and may be modified/deleted without 
affecting the rest.  The others will remain linked and behave accordingly.  
In other words, detaching from the other SuperItems makes the item 
behave like a standard item. 

 
 
 
Create a “standard” action item when assigning an item to 
only one person or project, or when you might like to modify 
the items independently of one another.  Use a “SuperItem” 
when you want to assign items to more than one person and 
project, and when you want changes to one item to appear 
across all people and projects.  You may change the behavior 
of drag and drop items so that all items dropped are 
SuperItems by default, by selecting this option inside the 
Preferences/Outline window. 
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Pending  
Pending is a review area, where you can perform a final check of an item before 
officially assigning it to a Person or Project.  Action items sent to the Pending area 
are still dynamically linked to the source item in the Journal.  If the Journal entry is 
amended, those changes will be reflected in the Pending item.  
 
Remember that items do not necessarily have to originate in the Journal – you can 
create an item from inside an Assigned Outline, and assign it to other entities.  It will 
go to their Pending Outline, maintaining a link to the source item until formally 
assigned. 
 
 

 
 
 
Pending is visible inside all outline views, except for Journal.  Once an item is in 
Pending, it can either be officially assigned to a Person or Project, or deleted.   
 

To Assign an Item – highlight item by clicking on it, then click  “Assign” 
 
To Delete an Item – highlight item by clicking on it, then press “Delete” (this 
will not delete the source note – only the item in pending.) 
 
To Assign via “Live Assign” – please see next section below 

 
 
Text cannot be changed from inside the Pending area, however, you may assign due 
dates and priorities from inside Pending (these functions can also be performed later 
inside Assigned Outlines).  Items can be amended for spelling or content when 
assigned to a Person or Project, or from inside the original notes.  Clicking on the 
origin date from inside Pending will take you back to the source item. 
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Once a standard item leaves Pending and has been assigned, it becomes 
independent of it’s origin.  Changes made to the original note inside the Journal will 
not be reflected in an assigned outline.  If you wish for this to take place, you must 
create a SuperItem. 

 
The true beauty of the “Pending” area is the ability to weed out real, 
actionable items versus items you may decide not to act upon.  Many 
ideas seem worthwhile initially (in a meeting, etc.), and upon later 
review, become less viable.  It also allows you to prioritize new items 
against existing items, and vice versa.  Use “Pending” as a holding area 
for items still to be discussed with its potential owner(s).  Once Pending 
items are discussed and reviewed, they can then be amended, 
assigned, and/or deleted. 
 
It is logical to assign priorities and due dates from inside Pending, 
before it is assigned, since they will travel with the item to the intended 
recipients’ outline. 

 
 
ActionItemsTM Live  
Anyone on your local network (subnet) is capable of sending/receiving and 
accepting/rejecting items via the ActionItemsTM Inbox feature, making ActionItemsTM 
the ultimate workgroup solution!  
 
As co-workers launch ActionItemsTM, it turns the bullet next to their name in the 
Listings window to “green”.  This person can now receive items into their Inbox.  If 
the intended party is off-line, any sent messages remain in your Pending until that 
person signs on.  
 

Preparing the Workgroup to Send and Receive Items  
Before sending and receiving action items between individuals, several 
important steps must be taken to ensure that each person in the group is 
recongnized. 
 
1. Each person should have a personal entry in their own ActionItemsTM database, 

created in the normal fashion (see page 7) and identified as themselves.  To 
do this, highlight your personal record, then select “Identify as Me” under the  
“Person” menu.  This allows others to “see” you on the network. When done, 
the icon next to your name will appear in blue. 
 

2. In order to “see” another person using ActionItemsTM, their name must 
appear in your database, and in their own personal record, in exactly the 
same way.  For example “Peter Smith” must be entered as “Peter Smith” in 
all places, not as “Pete Smith” in one program and “Peter Smith” in another. 
 

3. Each person must enable the networking feature from inside their 
Preferences window.  To do this, simply go to 
Preferences/Network/Receiving items, and check the box next to “Allow 
others to send items to me”. 

 
If all of the above is done correctly, a green dot appears in the "People” listing 
identifying each user that is visible.  Should you be “missing” someone in your 
group, please ensure that all steps above have been taken. 



ActionItems 2.5 for Mac OS X 

 17

Sending Live Action Items 
To Live Assign an item to someone on your local network, go to their Pending 
area and click on an item. Next, click on “Live Assign”.  The item will remain in 
Pending but the bullet will change color to “yellow”.  

 
If the recipient has ActionItemsTM running, the item will appear in their Inbox 
within seconds.  If they are off-line, it will remain in your Pending until they 
become available and either accept or reject it. 
 
If a person accepts a sent item, the bullet will change to “green” and the item 
will move to its Assigned Outline.  If the person rejects the sent item, the bullet 
will become “red”, and the item will remain in your Pending. 
 
From there, you may choose to delete it, re-send it, or do a “non-Live” assign.  

 
 

NOTE:  Modifying the OS X Firewall Setting  
If you are using the OS X built-in firewall and would like to receive 
action items over the network, you need to add an entry for the 
ActionItemsTM application in your firewall settings.  Inside “System 
Preferences”, under “Internet and Network”, click on “Sharing” and 
then go to the firewall tab.  Click on “New.”    You will be presented 
with a sheet asking for the port information.  Select “Other” for the 
Port Name and type in the port number that ActionItems is using.  
By default, the port number used by ActionItemsTM is 5351.  Finally, 
type in “ActionItems” for the Description and click “OK”.  

 
 

Viewing, Accepting and Rejecting Live Action Items 
Your Inbox lets you know how many items are in it at any time, by displaying a 
number to the immediate right.  To view items, simply click on your Inbox.  A 
complete listing of items appears in the Listings window, along with Sender, 
Due Date, Priority and Received Date.  
 
To accept an item in your Inbox, highlight it and click “Accept”. When accepted, 
the bullet becomes “green”, and the item moves from your Inbox to your 
personal assigned outline. 

 
To reject an item in your Inbox, highlight the item and click “Reject”.  This 
removes it from your Inbox and changes the bullet color to “red” in the 
sender’s Pending outline.  
 
 
 

Never again will an important work project get lost between the 
inter-office jokes, junk mail solicitations, and endless carbon 
copies found in your e-mail Inbox today!  Important directives are 
managed by ActionItems’TM own Inbox technology, keeping them 
out of the clutter and in plain sight. 
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Working with Assigned Action Items 
Once you have People, Projects and Groups composed, and action items assigned, it 
is now time to monitor progress.  ActionItemsTM allows you to do this through both 
the Assigned Action Items outlines, and in the Upcoming panel. 

 
Assigned Action Items Outlines 
“Assigned Action Items” Outlines are a compilation of notes and action items 
for a Project or Person.  Here is where items are organized, prioritized, 
amended and monitored for progress and completion. 
 

Viewing Assigned Outlines 
Assigned Outlines are viewable by clicking on the person or project in the 
Favorites bar across the top of the program window, or by clicking on 
“People” or “Projects” inside the Directory, and selecting a record in the 
Listing panel. 
 
Expanding/Contracting Viewable Area 
To expand the viewable area, pull down or double-click on the splitter bar 

between Assigned and Pending, or click on the  button to collapse the 
Pending area. To restore the original view, click on the icon again. 
 
Column Headers 
Various columns are available for display 
inside each Assigned Action Items outline.  
You may display all, or some of the 
columns at any given time by selecting or 
de-selecting them in the pull down menu 
along the right hand side of the column 
header row.  

 
 
People – displays any additional people the item may be assigned to. 
Clicking on a person listed in this column will take you to the 
corresponding item from inside their outline.  If there are no additional 
item owners, the column remains blank.  
 
Projects – displays any additional projects the item may be assigned 
to. Clicking on a project listed in this column will take you to that item 
inside the project outline.  If there are no additional item owners, the 
column remains blank.  
 
Origin – clicking on the date (for a Journal entry), or outline name (for 
an Assigned Outline) in the origin column takes you to the source notes 
inside the Journal area or Assigned Outline.  This is helpful when 
researching the context of an item, or when amending a SuperItem.  
 
Due Date – shows the assigned due date for the item.  If a due date 
has not yet been assigned, you may assign one by clicking in the 
column and selecting a date on the pop-up calendar.  Note:  items will 
not appear in “Upcoming” unless a due date has been assigned.  
Assigning a due date makes an item more trackable. 
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Priority ( ) – ActionItemsTM gives you the ability to assign priority 
codes to items inside an Assigned outline.  To assign a code, click in the 
column under heading ( ), and assign a code from 1 – 5, with one 
being the greatest.  You may change the Priority codes from numeric to 
alphabetic from inside the General Preferences window. 
 
Attachments ( )– To attach an external document to an item, simply 
click in the column under the heading ( ).  The dialog box will prompt 
you to create a path to where the document is stored.  Once 
completed, a page icon will appear in the links column.  Clicking on the 
icon pops-up a menu so you can open or delete existing attachments, 
as well as add another.  You can also drag and drop a file onto the 
item’s attachment column. 
 
Date Completed - displays item completion date. 
 
Date Created – displays item creation date. 
 
Modified – displays date the item was last modified. 
 

 
Changing Order of/Adding/Removing Columns 
To change the order of the columns, simply drag and drop them to the 
desired position.  To add or remove any of the columns, click on the arrow 
to the right of the column headings and either activate or deactivate the 
header in the drop-down box.   
 
Changing Colors of Status Codes  
The default colors of status codes are as follows: 
 
 Pending items: Blue 
 Assigned items: Black 
 Completed items: Gray 
 
Use the Preferences window to customize colors of these links. 
 
Once you have established an outline with assigned items, feel free to 
insert, delete, move, and edit items as you see fit. 
 
Inserting an Item 
Place the cursor at the end of the item above where you want the new one 
to appear, or select the item, and press “return”.  A new item is created at 
the same level as the previous item.  Press “tab” or “shift-tab” to indent or 
out-dent as desired.  Once the item is complete, you can perform any of the 
functions above, including due dates, priority codes, etc. 

 
Deleting a Standard Item   
Highlight the item, or use the arrow keys to navigate to it.  Once the item is 
highlighted, you can either press “delete” or you can select “Delete” from 
the “Edit” menu. You can also insert the cursor at the end of the item and 
backspace through it.   
 
 



Sailalong Software 

20 
 

Deleting a Super Item 
To delete a single occurrence of a “SuperItem”, first highlight the item and 
select “Unlink from Source” from the “Outline” menu.  You will be able to 
delete this item without affecting the other items.  To delete all occurrences 
of a SuperItem, click on the “Origin” column to get to the source note.  
Deleting this item will delete all occurrences. 
 
Moving an Item 
To move an item, click on the bullet (or arrow) and drag the item to a new    
location.  Note:  Dropping an item to the left of another item’s bullet will 
add it at the same level while dropping on the right side of the bullet will 
make it a child item. 
 

  Editing an Item 
To edit an item, click inside the item at the appropriate spot and enter your 
changes.  If the item is highlighted, you can press the Space Bar to begin 
editing and Esc to stop. 
 

 
Use Assigned Outlines to collect notes and action items 
regarding a project/person, make changes on dates, priorities, 
etc. Start directly inside the assigned outline when the notes are 
specific to that person or project.  Link external documents and 
files – keep all pertinent info under one easy header.  Retrieval 
becomes a breeze – no more hunting for related documents or 
ancillary notes! 
 

 
Upcoming  
The Upcoming view allows you to monitor and sort all action items coming due 
for a particular project or person.  It also provides a global view of all items 
across all categories. 
 
Items belonging to a particular person or project can be viewed by clicking on 
the “Upcoming” icon in the Directory while inside a specified outline.  Please be 
sure the “For current selection” box at the bottom of the window is selected.   
 
Upcoming items for all Projects and People can be viewed by making sure the 
“For current selection” box is de-selected.  All items with due dates within the  
days ahead selection will appear inside the viewing area (see screenshot 
below). 

 
You can adjust the time frame from which the action items are displayed by 
using the slider box or calendar controls at the bottom of the window. 
 

 
 
 
 
 
 
 
Adjusting “Days Ahead” View 
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To adjust the “Days Ahead” view either within or beyond the default 7 day 
window, you have two options: 
 

1) Click the arrow box up or down until the desired number appears in 
the window, or, 

 
2) Click on the calendar icon and select a fixed date. 

 

 
 
 
Sorting Items 
Items inside the “Upcoming Items” window can be sorted many ways.  Click 
on a column heading to sort in either ascending or descending order. 
 
To change the order of the columns, simply drag and drop them to the 
desired position. 
 

 
Use Upcoming as your ‘to do’ list.  Sort by and review upcoming dates 
for either an individual, or for all projects/people.   Arrange items by 
due date, people, projects and priority code.  Remember, you can 
adjust the number of days ahead you are viewing – by day, by week, 
by month or longer, or by a static deadline.   

 
 
Printing and Reporting 
ActionItemsTM outlines can be printed as outlines, as reports or saved as a .PDF 
for sharing and distribution. 

 
Printing 
ActionItemsTM allows you to print 
any of the outlines -- Journal, 
Assigned, Pending or Upcoming.  
Select Print from the File menu.  
The print dialog allows you to select 
an outline to print from the outlines 
you are currently viewing.  You can 
select the number of levels of 
children to print, whether or not you 
want to print the checkboxes and 
the font used. 



Sailalong Software 

22 
 

Reports 
To create a report, select “New” from the 
Reports menu.  A blank report template 
will appear, complete with design tools 
across the top of the window.  Moving 
your cursor over each tool will display its 
name.  Functions are described below: 
 

Move Tool:  Use the move tool to 
select, move and/or resize graphic 

elements, outlines, and text boxes.  To 
move more than one element at one 
time, click and drag to draw a box around the desired items.  Or, click on the first 
item, and shift-click on the others until all are highlighted, then move accordingly. 
 

Insert Outline Tool:  Use this tool to “draw” an outline for a custom report.  
The search criteria selection window will automatically appear, with a series 

of filters.   Select the desired criteria, and add new filter levels by clicking the “+” 
button.  You may remove selected filters by clicking the “-” button to the right of 
the row.  Continue selecting criteria until you are done, then click “OK”.  Next, 
choose the columns you wish to show by clicking on the back arrow in the upper 
right hand corner of the outline, and checking off the appropriate headers.  The 
complete outline will appear in “Preview” mode. 

 
Insert Text Label:  Use this tool to draw a text box for headers, company 
name, etc.  For info on text selection, etc. see the “Report Inspector” section 

below. 
 

Insert Line:  Use this tool to draw vertical, horizontal and diagonal lines to 
enhance your reports.  For info on line width, color, opacity, etc. see the 

“Report Inspector” section below. 
 

Insert Image:  Use this tool to insert any image into your report.  
 
 

Insert Rectangle:  Use this tool to draw squares and rectangles.  For info 
on line width, color, fill, opacity, etc. see the “Report Inspector” section 

below. 
 

Show Inspector:  Click on “Show Inspector” to bring up the Report 
Inspector palate. To learn more about the Report Inspector, please see 

below. 
    
 

Report Inspector 
The Report Inspector is a floating palate used to select and adjust the 
many design elements of your reports.  Below is a complete description 
of the Report Inspector controls and their respective functions. 

 
 

Position:  Displays the position of a 
selected outline, text box, or graphic 
element in relation to the upper left 
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hand corner of the report sheet.  
Increments are measured in pixels.  The 
value will change as the item is moved on 
the page.  Additionally, you may move the 
element by changing the values in the 
boxes via the up and down arrows.   
 
 
Fixed position:  anchors element to its position on the page.  Useful for 
headers and footers. 

 
Appears on every page:  repeats element on every page – useful for 
logos, stylized headers and footers. 
 
Watermark:  adds opaque quality to graphic element, so that type may 
overlay.  Useful for logos, etc. 
 

Size:  Displays the size of a 
selected text box, or graphic.  
Increments are measured in pixels. 
You may resize the element by 
changing the values in the boxes via 
the up and down arrows.   

 
Maintain Proportions:  select this for 

distortion-free resizing of photos, logos, etc. 
 
 
Graphic:  Allows you to adjust line 
width and color, and fill color with an 
almost endless selection of 
enhancement capabilities. 

 
Line:  resize width by adjusting value in 
the box via up and down arrows, or by 
entering a value inside the box.  Adjust 
the color by double-clicking on the 
rectangle and bringing up the color 
tools. 
 
Fill:  Click on the gray scale slider to adjust brightness.  Choose from a 
variety of color enhancement/selection tools via the Color Palette as 
shown, right. 
 
Opacity:  move the slider bar to achieve a translucent quality to the 
highlighted element. 

 
 
 

Text:  Use the tools inside the text area to 
choose font, color, size, alignment and more.  
Insert page numbers, date stamp, time stamp 
and template text. 
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Outline:  Use the outline controls to 
adjust font selection and size inside your 
outlines and column headers.  Pull up a 
list of all available fonts and styles by 
clicking the box to the right of the text 
selection window. 
 
 
Margins:  The margin controls allow 
you to adjust top and side margin size, 
and elect to show or hide margin guides. 
 
 
Grid:  Clicking on “grid” will create a 
background on your report to use as a 
guide for alignment purposes.  The grid 
will not appear in “Preview” mode, nor 
will it print.   
 
Selecting “Snap to grid” will “magnetize” 
the grid line, helping to line up various 
elements in the report creation process. 

 
 
Once your report is created, you will want to preview them before printing.   
Clicking the “Preview” button at the top of the report will bring up all pages of 
your reports, complete with outline data, page numbers, repeating elements, 
etc.  To adjust any of the features, return to “Design” mode to make the 
appropriate corrections.   Once the preview is just the way you like it, save 
and name your report for re-use before printing. 
 
 

The options for reports are limited only by your personal needs 
and creativity.  You may have several outlines appear in one 
report, all with different search criteria.  Any text headers placed 
between outlines will automatically flow to the proper location as 
the outlines expand and contracts. 

 
For example:  to create a Weekly Progress Report for all direct reports, insert 
an outline for each person, with a text header over each outline.  Continue to 
do so for all direct reports in the design section.  In Preview mode, you will 
notice that the headers flow automatically to the end of the previous outline, 
without being overwritten. 
 
Saving an Outline in .PDF format 
To save an outline as a .PDF, select “PDF” from inside the Print dialog box.  
The application will automatically save your text to the destination of your 
choice in .PDF format.   
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Importing 
ActionItemsTM supports several kinds of import and export functions as listed 
below. 

 
Importing from Address Book 
ActionItemsTM allows you to import contacts from your address book, either 
maintaining links, or importing data to act independently of address book 
record. For complete info on importing from address book, see page 7. 
 
Importing Data 
When you run ActionItemsTM 2.5 for the first time, it will search your system 
to see if there is an existing version 2.0 data file.  If one is found, you will be 
asked if you would like create a blank data file or import your 2.0 data. 

 
 

Completing Action Items 
 As individual items are completed, clicking on the check box next to the item 

marks them as done.  When the item is checked off, the due date will change to 
grey, indicating completion.  ActionItemsTM employs Smart Checkbox 
technology, so that checking off a parent item will also mark the children of that 
item as complete.  Similarly, completing all of the children under an item will 
check off the parent as well.  Checking off a SuperItem in one outline will check it 
off across all other outlines (to unlink a SuperItem so that this does not occur, 
highlight the item and go to Outline/Detach from Super Item). 

 
Once an item is checked as completed, it will be hidden from your outline after a 
specified amount of time; the default setting is seven days.  You can change the 
duration in the Preferences area under “Outline/Completed Items”.  Simply adjust 
the number inside the box to the desired interval.   

 
Adding and Removing Checkboxes 
If you wish to view an item in pure note form, as opposed to a checkable 
item, you may remove the checkbox by highlighting the item and selecting 
“Remove Checkbox” from the “Outline” menu.  To add a checkbox to an 
item, highlight the item and select “Add Checkbox” from the “Outline” 
menu. 
 
You may also choose whether newly created items start with or without 
checkboxes by using the Outline menu option (Show/Remove checkboxes), 
or by using the checkbox button at the right-hand bottom side. 

 
 
Ready to Go! 
Now that you are familiar with the many features of ActionItems 2.5 Notes-to-
Action software, you are ready to begin!  Please refer to the Help section inside 
the program for any help you may require, or e-mail techsupport@Sailalong.com 
for technical issues pertaining to the functioning of the software.  You may also 
select “Provide ActionItems Feedback” from the ActionItems menu, which will 
bring you to Sailalong.com’s feedback page. 
 
We hope you enjoy the increased productivity and efficiency that ActionItems will 
bring to your everyday life!   
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Preferences  
 
The Preferences window can be found under the ActionItemsTM menu, and allows you 
to make the following customizations: 
 
General  
  

Favorites:    select number of favorites shown in favorites bar 
 
Name Format:    show names as first/last or last/first, sort by last or first 
 
Date Format:    select date display format from a variety of options, choose first day 

of week 
 
Priority Format:  alpha, numeric or combination 
 
Journal:   whether or not to allow checkboxes 
 
 

Outlines  
 
Spelling:    enable or disable spell checking while you type 
 
Outline Font:   select font to be used for outline text 
 
Column Font:   select font to be used for text in the columns 
 
Hot Keys:    designate signifiers for standard item and super item, enable or disable 

“check for hot keys while you type”. 
 
Dragging:  select assignment type when dragging an item (assigned as a standard 

item or a super item). 
 
Completed Items: select number of days completed items are hidden from outlines, or 

disable.  Select number of days completed items are archived, or disable.  
 
Appearance:    modify colors for pending items, assigned items, and completed 

items.  Enable or disable alternating row background colors in all 
outlines. 

 
Reports 
 

Report Directory:  select location for Reports Directory storage 
 
 
Network     
   

Receiving Items: elect to accept incoming items or not – must be selected to use 
in workgroup environment 

 
Sending Items:  elect to search the network for available users, adjust frequency 

in which items are re-sent 
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Updates  adjust frequency application checks for updates on 
Sailalong.com web site, or “Check for updates now” 

 
Glossary  

 
Address Book Integration  
Selecting “Import” from the “File” menu will bring up a list of contacts from your 
system address book.  You can select one or more contacts and import them into 
ActionItemsTM. 
 
Assigned Action Items Outline 
Assigned Outlines are compilations of notes and items assigned to specific People 
or Projects.  Use this view to keep track of your favorite people and projects. 
 
Attachments ( ) 
External documents and files can be linked to Assigned Outline items, keeping all 
pertinent documents stored in one place.  To link a document to an item, click in 
the column with the paperclip heading.  This pops-up a menu for opening, 
adding, or deleting linked documents.  Or, drag and drop a file onto the 
attachments column inside the item. 
 
File formats supported: MP3, PDF, TIFF, JPEG, GIF, BMP, PSD, PICT, PNT, 
EPS, PS, EPI, TARGA, RGB, SGI, PNG, MAC, FPIX, FAX, ICNS, ICO, and CUR 
files. 

 
AutoSave 
ActionItemsTM will periodically save the contents of your data file according to the 
frequency selected inside your Preferences file.  The program will also perform an 
automatic save upon closing.  
 
AutoSend 
The AutoSend feature instantly sends Live Assign items over the network to the 
intended recipient. If the recipient is not online at the time the item is sent, it will 
remain in your Pending until the recipient is online.  
 
Backup to file  
Creates a backup of your ActionItemsTM data file in the location of your choice. 
 
Calendar  
The calendar appears along the left hand side of the Journal view.  The typical 
display is a three-month view, which varies depending on the size of your 
program window.  The calendar allows you to navigate to journal notes for one or 
more dates by clicking on the desired date(s). 
 
Check for Updates 
Accesses the Sailalong site for new version upgrades to the ActionItemsTM  
program. 
 
Child(ren) 
An item that is indented below another item. 
 
Created Date 
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The created date indicates when an item was either created or assigned. 
 
Days Ahead  
Items that have been given due dates will appear in Upcoming.  Adjust the 
number inside the days ahead box to view items due within a specific time frame. 
 
Directory  
The Directory panel allows you to browse between People, Projects, Groups, 
Upcoming, Searches, Reports, and Inbox. 

 
Drag and Drop 
Drag and drop is a simple way to assign items to a person or project.  It also 
allows you to attach external documents to an item inside an assigned outline.  
To perform a drag and drop, click on the item you wish to move, drag it to the 
desired location and then release.  
 
Date Modified 
“Date modified” updates each time a change is made to an assigned item.  To 
view the date modified column inside Assigned Outlines, click on the arrow in the 
row across the top of the outline window and scroll to “ Date Modified”, which 
adds that column to the window. 
 
Due Date 
Indicates when a project or item is due for completion. Items that have assigned 
due dates will appear in Upcoming. To assign a due date, click in the due date 
column and select a date from the calendar. Items in either Pending or Assigned 
Outlines can be given due dates. 

 
Favorites 
Favorites appear across the top of the window just above the outline.  They 
represent recently viewed people or projects.  Along with the “Journal”, you can 
choose to have your most frequently accessed projects or people remain in 
permanent view for easier access by dragging them between the two vertical 
lines next to the Journal display in the Favorites bar.  To access options for 
favorites, go to the General Preferences menu. 
 
Groups 
Create custom groups to organize people and projects.  A person or project can 
belong to more than one group. 
 
Hot Keys 
Hot Keys are a shorthand way of including a person or project in an item. When 
typing in an item, type the hot key character followed by the hot key and that 
item will automatically be sent to pending for the person or project. 
  
 Example: For Joseph Ball, you may specify his hot key as “JB”. 
 
Hot Key Character 
The hot key character is a signifying character used before the hot key when 
typing in an item.  You can select the hot key character of your choice under 
Outlines in Preferences. 
  
       Note:  The default hot key character for a standard item is \ 
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   The default hot key character for a super item is / 
 
Hot Key Text 
Hot Key Text is a text string designated by you to replace the hot key characters 
entered inside an item. 
  
Example: You have a person names “Joseph Ball” with a Hot Key of “JB”, and 
Hot Text of “Joseph Ball”.  The “\JB” you type inside an item to assign it to Joe 
will be replaced with “Joseph Ball”. 
 
You may disable this feature when setting up an individual person or project by 
leaving the field blank.  

 
Import from Address Book  
Imports selected contacts from your Address Book. 
 
Inbox  
The ActionItemsTM  Inbox holds incoming action items sent to you by a co-worker 
on your local network.  Once you “Live Assign” an item to another person, you 
will receive a message in your inbox indicating whether the recipient has 
accepted or rejected the assignment.  You may also receive a notification when 
the item is complete. 
 
Journal 
The Journal is the primary place to record notes of all kinds.  The Journal is the 
default view when opening ActionItemsTM.  Use the Journal as a scratchpad to jot 
down notes and ideas that are not yet related to other people or projects, or to 
record meeting notes, lists, etc. 
 
Listing  
The Listing panel allows you to view all records for a selected Directory item. 
 
Live Assign 
Send action items to others on your local network who are running the program 
by clicking “Live Assign” when the item is highlighted in their Pending file.  
Recipients must be on the network in order to receive action items; items will 
stay in your Pending until the person is available.  

 
Navigation Area 
The Navigation area allows you to select a group, project or person, view 
Upcoming Items, perform searches, and access your Inbox. 
 
Open in Address Book  
Opens address book record for person highlighted in ActionItemsTM. 

 
Origin 
The Origin indicates where the item came from.  The Origin can be a date, person 
or project.  Clicking on the Origin will take you to the source item. 

 
Parent  
An item that has one or more items indented below it. 
 
Pending 
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Pending is a place to review items before actually assigning them to a person or 
project.  Pending items simply point to the source item in the Journal or Assigned 
outline and therefore cannot be modified or edited.  However, you can assign 
priorities and due dates. If you need to modify the item, click on the Origin link. 

 
People 
Individual contacts to whom you can assign action items. 
 
Preferences  
There are many ways to customize ActionItemsTM for your usage.  You can access 
Preferences under the “ActionItems” menu and select from General, Appearance, 
outlines, Data files, Network and Update.  A complete description of each 
selection is contained in the “Preferences” section of this manual. 
 
Priority Code ( ) 
Items in pending, upcoming items or assigned may all be given a priority code. 
The default codes are 1 – 5, with 1 being the most important.  Priority code 
designations may be customized inside the Preferences window. 
 
Projects 
Create Project for your major activities and undertakings.  Once your projects are 
set up, you can assign action items to it, and take notes directly in the specific 
outline.  In creating the project you can give it a Hot Key designation, original 
due date and completion date, as well as notes about the purpose and mission of 
project. 
 
Provide ActionItemsTM feedback 
Brings you to Sailalong.com, where you can provide feedback and product-
related issues to our technical development team. 
 
QuickFind 
Allows you to quickly access a text string inside any/all outlines as specified.  You 
may also perform a search and replace from inside QuickFind. 
 
Recently Viewed Favorites 
Viewing assigned and pending outlines for a person or project, will create a 
“favorite” status for that person or project at the top of the window.  To modify 
the number of recent favorites shown, adjust the number under “General” in the 
Preferences window. 
 
Restore from file  
Re-writes the existing ActionItemsTM data file with your previously established 
backup file. 
 
Rich Text Format (RTF) Support 
ActionItemsTM supports bold, italic, underline, colors, system fonts and sizes. You 
can customize the text of an item by selecting a style from the “Format” menu. 

 
Search  
Create your own searches using a variety of criteria.  All custom searches are 
automatically saved for re-use at a later date. You can also delete custom 
searches you don't wish to keep. 
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Smart Checkboxes  
ActionItemsTM uses Smart Checkbox technology.  This allows you to check off a 
parent item, and the outline will check off all the children as well.  If you check 
off a child and there are other items yet to be completed, the parent item will 
display a dash in the checkbox denoting a mixed state among the children.  Once 
all children are checked off, the parent will automatically check as complete. 
 
Special Characters  
Brings up character palate with menu of symbols available for use. 
 
Speech 
The system can speak your outline to you!  To hear the entire outline, highlight 
item(s) in the outline and select “Speech” under ActionItems > Services > 
Speech.   
 
Spell Checking 
You can spell check your entire outline by selecting “Spelling” under the “Edit” 
menu.  Collapsed items will not be spell checked.  You may also select “check 
spelling as you type”, which will automatically underline unrecognizable words in 
red. 
 
SuperItem 
SuperItems are action items appearing in multiple outlines that are dynamically 
linked to each other. Changing the original item will automatically change all 
instances of the item. SuperItems are useful when assigning an item to more 
than one owner. 

 
SuperItems are created by using a different Hot Key signifier as designated in the 
Preferences window.  SuperItems are differentiated from a standard action item 
by a blue bullet point (versus grey for a standard item), and an italicized 
owner/project/due dates, which also appear in blue. 

 
Upcoming 
Upcoming keeps track of all due dates assigned to people, projects and tasks.  
Use it as a “to do” list for individual projects, or spanning across all projects and 
people in your file. 
 
 

 
Reference 
 
Keyboard Shortcuts menu 
 
Insert Item    Return  
Delete Item    Del  
Indent     Tab  
Outdent      Shift-Tab  
Edit Item     Space Bar or Ctrl-Return 
Stop Editing    Esc  
Insert New Line    Shift Return  
Move Between Items   Up/Down Arrow  
Collapse Item    Click Left Arrow  
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Expand Item    Click Right Arrow  
 
 
 
Using the Mouse  
 
Edit Item     Click on Item Text  
Stop Editing    Click Outside the Item Text  
Drag Item     Click on Bullet or Arrow  
Expand/Collapse Item  Click Arrow  
 
 
Columns  
 
Hide/Show Column  
You can hide or show any column by clicking on the arrow at the right side of the 
column headings and selecting the column name.  
 
Sort Column  
Click on the column heading to sort in either ascending or descending order.  
 
Move Column  
To move a column, click on the column heading and drag it to the left or right to 
customize the order in which the columns are displayed. 


